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DISCLAIMER 1 

Certain commercial entities, equipment, products, or materials may be identified by name or company 2 
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an 3 
experimental procedure or concept adequately. Such identification is not intended to imply special 4 
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it 5 
intended to imply that the entities, equipment, products, or materials are necessarily the best available 6 
for the purpose. 7 

 

National Institute of Standards and Technology Special Publication 1800-30C, Natl. Inst. Stand. Technol. 8 
Spec. Publ. 1800-30C, 140 pages, (November 2020), CODEN: NSPUE2 9 

 

FEEDBACK 10 

You can improve this guide by contributing feedback. As you review and adopt this solution for your 11 
own organization, we ask you and your colleagues to share your experience and advice with us.  12 

Comments on this publication may be submitted to: hit_nccoe@nist.gov. 13 

Public comment period: November 16, 2020 through December 18, 2020 14 

As a private-public partnership, we are always seeking feedback on our practice guides. We are 15 
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you 16 
have implemented the reference design, or have questions about applying it in your environment, 17 
please email us at hit_nccoe@nist.gov. 18 

All comments are subject to release under the Freedom of Information Act. 19 
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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE 26 

The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards 27 
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and 28 
academic institutions work together to address businesses’ most pressing cybersecurity issues. This 29 
public-private partnership enables the creation of practical cybersecurity solutions for specific 30 
industries, as well as for broad, cross-sector technology challenges. Through consortia under 31 
Cooperative Research and Development Agreements (CRADAs), including technology partners—from 32 
Fortune 50 market leaders to smaller companies specializing in information technology security—the 33 
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity 34 
solutions using commercially available technology. The NCCoE documents these example solutions in 35 
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework 36 
and details the steps needed for another entity to re-create the example solution. The NCCoE was 37 
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County, 38 
Maryland. 39 

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit 40 
https://www.nist.gov. 41 

NIST CYBERSECURITY PRACTICE GUIDES 42 

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity 43 
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the 44 
adoption of standards-based approaches to cybersecurity. They show members of the information 45 
security community how to implement example solutions that help them align with relevant standards 46 
and best practices, and provide users with the materials lists, configuration files, and other information 47 
they need to implement a similar approach. 48 

The documents in this series describe example implementations of cybersecurity practices that 49 
businesses and other organizations may voluntarily adopt. These documents do not describe regulations 50 
or mandatory practices, nor do they carry statutory authority.  51 

ABSTRACT 52 

Increasingly, healthcare delivery organizations (HDOs) are relying on telehealth and remote patient 53 
monitoring (RPM) capabilities to treat patients at home. RPM is convenient and cost-effective, and its 54 
adoption rate has increased. However, without adequate privacy and cybersecurity measures, 55 
unauthorized individuals may expose sensitive data or disrupt patient monitoring services. 56 

RPM solutions engage multiple actors as participants in a patient’s clinical care. These actors include 57 
HDOs, telehealth platform providers, and the patients themselves. Each participant uses, manages, and 58 
maintains different technology components within an interconnected ecosystem, and each is 59 

https://www.nccoe.nist.gov/
https://www.nist.gov/
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responsible for safeguarding their piece against unique threats and risks associated with RPM 60 
technologies. 61 

This practice guide assumes that the HDO engages with a telehealth platform provider that is a separate 62 
entity from the HDO and patient. The telehealth platform provider manages a distinct infrastructure, 63 
applications, and set of services. The telehealth platform provider coordinates with the HDO to 64 
provision, configure, and deploy the RPM components to the patient home and assures secure 65 
communication between the patient and clinician. 66 

The NCCoE analyzed risk factors regarding an RPM ecosystem by using risk assessment based on the 67 
NIST Risk Management Framework. The NCCoE also leveraged the NIST Cybersecurity Framework, NIST 68 
Privacy Framework, and other relevant standards to identify measures to safeguard the ecosystem. In 69 
collaboration with healthcare, technology, and telehealth partners, the NCCoE built an RPM ecosystem 70 
in a laboratory environment to explore methods to improve the cybersecurity of an RPM.  71 

Technology solutions alone may not be sufficient to maintain privacy and security controls on external 72 
environments. This practice guide notes the application of people, process, and technology as necessary 73 
to implement a holistic risk mitigation strategy.  74 

This practice guide’s capabilities include helping organizations assure the confidentiality, integrity, and 75 
availability of an RPM solution, enhancing patient privacy, and limiting HDO risk when implementing an 76 
RPM solution. 77 

KEYWORDS 78 

access control; authentication; authorization; behavioral analytics; cloud storage; data privacy; data 79 
security; encryption; HDO; healthcare; healthcare delivery organization; remote patient monitoring; 80 
RPM; telehealth 81 
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1 Introduction 106 

The following volumes of this guide show information technology (IT) professionals and security 107 
engineers how we implemented this example solution. We cover all of the products employed in this 108 
reference design. We do not re-create the product manufacturers’ documentation, which is presumed 109 
to be widely available. Rather, these volumes show how we incorporated the products together in our 110 
environment. 111 

Note: These are not comprehensive tutorials. There are many possible service and security configurations 112 
for these products that are out of scope for this reference design. 113 

1.1 How to Use this Guide 114 

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a 115 
standards-based reference design and provides users with the information they need to replicate the 116 
telehealth remote patient monitoring (RPM) environment. This reference design is modular and can be 117 
deployed in whole or in part. 118 

This guide contains three volumes: 119 

 NIST SP 1800-30A: Executive Summary 120 

 NIST SP 1800-30B: Approach, Architecture, and Security Characteristics – what we built and why 121 

 NIST SP 1800-30C: How-To Guides – instructions for building the example solution (you are 122 
here) 123 

Depending on your role in your organization, you might use this guide in different ways: 124 

Business decision makers, including chief security and technology officers, will be interested in the 125 
Executive Summary, NIST SP 1800-30A, which describes the following topics: 126 

 challenges that enterprises face in securing the remote patient monitoring ecosystem 127 

 example solution built at the NCCoE 128 

 benefits of adopting the example solution 129 

Technology or security program managers who are concerned with how to identify, understand, assess, 130 
and mitigate risk will be interested in NIST SP 1800-30B, which describes what we did and why. The 131 
following sections will be of particular interest: 132 

 Section 3.4, Risk Assessment, describes the risk analysis we performed. 133 

 Section 3.5, Security Control Map, maps the security characteristics of this example solution to 134 
cybersecurity standards and best practices. 135 
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You might share the Executive Summary, NIST SP 1800-30A, with your leadership team members to help 136 
them understand the importance of adopting standards-based commercially available technologies that 137 
can help secure the RPM ecosystem. 138 

IT professionals who want to implement an approach like this will find this whole practice guide useful. 139 
You can use this How-To portion of the guide, NIST SP 1800-30C, to replicate all or parts of the build 140 
created in our lab. This How-To portion of the guide provides specific product installation, configuration, 141 
and integration instructions for implementing the example solution. We do not recreate the product 142 
manufacturers’ documentation, which is generally widely available. Rather, we show how we 143 
incorporated the products together in our environment to create an example solution. 144 

This guide assumes that IT professionals have experience implementing security products within the 145 
enterprise. While we have used a suite of commercial products to address this challenge, this guide does 146 
not endorse these particular products. Your organization can adopt this solution or one that adheres to 147 
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing 148 
parts of the National Cybersecurity Center of Excellences’ (NCCoE’s) risk assessment and deployment of 149 
a defense-in-depth strategy in a distributed RPM solution. Your organization’s security experts should 150 
identify the products that will best integrate with your existing tools and IT system infrastructure. We 151 
hope that you will seek products that are congruent with applicable standards and best practices. 152 
Section 3.6, Technologies, lists the products that we used and maps them to the cybersecurity controls 153 
provided by this reference solution. 154 

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a 155 
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and 156 
success stories will improve subsequent versions of this guide. Please contribute your thoughts to 157 
hit_nccoe@nist.gov.  158 

Acronyms used in figures are in the List of Acronyms appendix. 159 

1.2 Build Overview 160 

The NCCoE constructed a virtual lab environment to evaluate ways to implement security capabilities 161 
across an RPM ecosystem, which consists of three separate domains: patient home, telehealth platform 162 
provider, and healthcare delivery organization (HDO). The project implements virtual environments for 163 
the HDO and patient home while collaborating with a telehealth platform provider to implement a 164 
cloud-based telehealth RPM environment. The telehealth environments contain simulated patient data 165 
that portray relevant cases that clinicians could encounter in real-world scenarios. The project then 166 
applies security controls to the virtual environments. Refer to NIST Special Publication (SP) 1800-30B, 167 
Section 5, Security Characteristic Analysis, for an explanation of why we used each technology.   168 

mailto:hit_nccoe@nist.gov
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1.3 Typographic Conventions 169 

The following table presents typographic conventions used in this volume. 170 

Typeface/Symbol Meaning Example 

Italics file names and path names; 
references to documents that 
are not hyperlinks; new 
terms; and placeholders 

For language use and style guidance, 
see the NCCoE Style Guide. 

Bold names of menus, options, 
command buttons, and fields 

Choose File > Edit. 

Monospace command-line input, 
onscreen computer output, 
sample code examples, and 
status codes 

mkdir 

Monospace Bold command-line user input 
contrasted with computer 
output 

service sshd start 

blue text link to other parts of the 
document, a web URL, or an 
email address 

All publications from NIST’s NCCoE 
are available at 
https://www.nccoe.nist.gov. 

1.4 Logical Architecture Summary 171 

Figure 1-1 illustrates the reference network architecture implemented in the NCCoE virtual 172 
environment, initially presented in NIST SP 1800-30B, Section 4.5, Final Architecture. The HDO 173 
environment utilizes network segmenting similar to the architecture segmentation used in NIST SP 1800-174 
24, Securing Picture Archiving and Communication System (PACS) [1]. The telehealth platform provider is 175 
a vendor-managed cloud environment that facilitates data transmissions and communications between 176 
the patient home and the HDO. Patient home environments have a minimalistic structure, which 177 
incorporates the devices provided by the telehealth platform provider. 178 

https://www.nccoe.nist.gov/
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Figure 1-1 Final Architecture 179 

 

2 Product Installation Guides 180 

This section of the practice guide contains detailed instructions for installing and configuring all the 181 
products used to build an instance of the example solution. This practice guide implemented several 182 
capabilities that included deploying components received from telehealth platform providers and 183 
components that represent the HDO. The telehealth platform providers provisioned biometric devices 184 
that were deployed to a patient home environment. Within the HDO, this practice guide deployed 185 
network infrastructure devices to implement network zoning and configure perimeter devices. This 186 
practice guide also deployed security capabilities that supported vulnerability management and a 187 
security incident event management (SIEM) tool. The following sections detail deployment and 188 
configuration of these components.  189 

2.1 Telehealth Platform Provider 190 

This practice guide implemented a model where an HDO partners with telehealth platform providers to 191 
enable RPM programs. Telehealth platform providers are third parties that, for this practice guide, 192 
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configured, deployed, and managed biometric devices and mobile devices (e.g., tablets) that were sent 193 
to the patient home. The telehealth platform provider managed data communications over cellular data 194 
where patients send biometric data to the telehealth platform provider. The telehealth platform 195 
provider implemented an application that allowed clinicians to access the biometric data. 196 

This practice guide collaborated with two independent telehealth platform providers. Collaborating with 197 
two unique platforms enabled the team to apply NIST’s Cybersecurity Framework [2] to multiple 198 
telehealth platform implementations. One platform provides biomedical devices enabled with cellular 199 
data. These devices transmitted biometric data to the cloud-based telehealth platform. The second 200 
platform provider deployed biometric devices enabled with Bluetooth wireless technology. Biometric 201 
devices communicated with an interface device (i.e., a tablet). The telehealth platform provider 202 
configured the interface device by using a mobile device management solution, limiting the interface 203 
device’s capabilities to those services required for RPM participation. The patient transmitted biometric 204 
data to the telehealth platform provider by using the interface device. The interface device transmitted 205 
data over cellular data communications. Both telehealth platform providers allowed HDOs to access 206 
patient data by using a web-based application. Both platforms implemented unique access control 207 
policies for access control, authentication, and authorization. 208 

2.1.1 Accuhealth 209 

Accuhealth provided biometric devices that included cellular data communication. Accuhealth also 210 
included a cloud-hosted application for HDOs to access patient-sent biometric data. Accuhealth 211 
provisioned biomedical devices with subscriber identity module (SIM) cards that enabled biomedical 212 
devices to transmit data via cellular data communications to the Accuhealth telehealth platform. 213 
Accuhealth stored patient-transmitted data in an application. Individuals assigned with clinician roles 214 
accessed transmitted data hosted in the Accuhealth application. The biomedical data displayed in the 215 
following screen captures are notional in nature and do not relate to an actual patient. 216 

2.1.1.1 Patient 217 

This practice guide assumed that the HDO enrolls the patient in an RPM program. Clinicians would 218 
determine when a patient may be enrolled in the program appropriately, and conversations would occur 219 
about understanding the roles and responsibilities associated with participating in the RPM program. 220 
When clinicians enrolled patients in the RPM program, the HDO would collaborate with Accuhealth. 221 
Accuhealth received patient contact information and configured biometric devices appropriate for the 222 
RPM program in which the patient was enrolled. Accuhealth configured biometric devices to 223 
communicate via cellular data. Biometric devices, thus, were isolated from the patient home network 224 
environment. Accuhealth assured device configuration and asset management. 225 
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2.1.1.2 HDO 226 

The Accuhealth solution includes installing an application within the HDO environment. Clinicians access 227 
a portal hosted by Accuhealth that allows a clinician to view patient biometric data. The application 228 
requires unique user accounts and role-based access control. System administrators create accounts and 229 
assign roles through an administrative console. Sessions from the clinician to the hosted application use 230 
encryption to ensure data-in-transit protection.  231 

This section discusses the HDO application installation and configuration procedures.  232 

1. Access a device that has a web browser. 233 

2. Navigate to accuhealth login page and provide a Username and Password. The following 234 
screenshots show a doctor’s point of view in the platform. 235 

3. Click LOG IN. 236 

 

After logging in, the Patient Overview screen displays. 237 
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4. To view patients associated with the account used to log in, navigate to the View Select drop-238 
down list in the top left corner of the screen, and select My Patients. 239 

 

5. Click a Patient to display the Patient Details page, which displays all patient biomedical 240 
readings. 241 



DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 8 

 

6. To leave a comment on a reading, click no comments yet under the Comments column on the 242 
row of the reading to which the comment refers. 243 

7. A Comment screen displays that allows free text input. 244 

8. Click Comment. 245 

9. Click Close. 246 
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10. To have a call with a patient, click Request an Appointment in the top left of the Patient Details 247 
page.  248 

11. A notification box displays, asking if the Home Health Agency needs to schedule an appointment 249 
with the patient.  250 

12. Click OK.  251 

 

2.1.2 Vivify Health 252 

Vivify provided biometric and interface devices (i.e., Vivify provisioned a tablet device) and a cloud-253 
hosted platform. Vivify enabled biometric devices with Bluetooth communication and provisioned 254 
interface devices with SIM cards. Individuals provisioned with patient roles used the interface device to 255 
retrieve data from the biometric devices via Bluetooth. Individuals acting as patients then used the 256 
interface device to transmit data to Vivify using cellular data. Vivify’s application presented the received 257 
data. Individuals provisioned with clinician roles accessed the patient-sent data stored in the Vivify 258 
application via a web interface. 259 

2.1.2.1 Patient 260 

This practice guide assumed that the HDO enrolls the patient in an RPM program. Clinicians would 261 
determine when a patient may be enrolled in the program appropriately, and conversations then occur 262 
about understanding the roles and responsibilities associated with participating in the RPM program. 263 
When clinicians enroll patients in the RPM program, the HDO would collaborate with Vivify. Vivify 264 
received patient contact information and configured biometric devices and an interface device (i.e., 265 
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tablet) appropriate for the RPM program in which the patient was enrolled. Vivify assured device 266 
configuration and asset management. 267 

2.1.2.2 HDO 268 

The Vivify solution includes installing an application within the HDO environment. Clinicians access a 269 
portal hosted by Vivify that allows a clinician to view patient biometric data. The application requires 270 
unique user accounts and role-based access control. System administrators create accounts and assign 271 
roles through an administrative console. Sessions from the clinician to the hosted application use 272 
encryption to ensure data-in-transit protection.  273 

This section discusses the HDO application installation and configuration procedures. 274 

1. Access a device that has a web browser.  275 

2. Navigate to https://demonccoerpm.vivifyhealth.com/CaregiverPortal/index.html#/Login and 276 
provide the Username and Password of the administrative account provided by Vivify. 277 

3. Click Login. 278 

 279 

4. Navigate to the Care Team menu item on the left-hand side of the screen. 280 

Click + New User. 281 

https://demonccoerpm.vivifyhealth.com/CaregiverPortal/index.html#/Login
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5. In the New User screen provide the following information: 282 

a. First Name: Test 283 

b. Last Name: Clinician 284 

c. User Name: TClinician1 285 

d. Password: ********** 286 

e. Confirm Password: ********** 287 

f. Facilities: Vivify General 288 

g. Sites: Default 289 

h. Roles: Clinical Level 1, Clinical Level 2 290 

i. Email Address: ********** 291 

j. Mobile Phone: ********* 292 

6. Click Save Changes. 293 

7. Navigate to Patients in the left-hand menu bar. 294 

8. Select the NCCoE, Patient record.  295 

9. Under Care Team, click the notepad and pencil in the top right of the box.  296 

10. In the Care Team window, select Clinician, Test and click Ok.  297 

11. Logout of the platform. 298 

12. Login to the platform using the Test Clinician credentials and click Login.  299 

13. Click the NCCoE, Patient record.  300 

14. Navigate to the Monitoring tab to review patient readings.  301 

15. Based on the patient’s data, the clinician needs to consult the patient. 302 

16. Click the ellipsis in the NCCoE, Patient menu above the green counter. 303 

17. Select Call Patient.  304 

18. In the Respond to Call Request screen, select Phone Call Now.  305 

19. After the consultation, record the action items performed during the call. 306 

20. In the Monitoring window, click Accept All under the Alerts tab to record intervention steps. 307 
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21. In the Select Intervention window, select the steps performed to address any patient alerts. 308 

22. Click Accept.  309 

23. Navigate to Notes to review recorded interventions or add other clinical notes. 310 

2.2 Security Capabilities 311 

The following instruction and configuration steps depict how the NCCoE engineers along with project 312 
collaborators implemented provided cybersecurity tools to achieve the desired security capabilities 313 
identified in NIST SP 1800-30B, Section 4.4, Security Capabilities.  314 

2.2.1 Risk Assessment Controls 315 

Risk assessment controls align with the NIST Cybersecurity Framework’s ID.RA category. For this practice 316 
guide, the Tenable.sc solution was implemented as a component in an HDO’s risk assessment program. 317 
While Tenable.sc includes a broad functionality set, this practice guide leveraged Tenable.sc’s 318 
vulnerability scanning and management capabilities. 319 

2.2.1.1 Tenable.sc 320 

Tenable.sc is a vulnerability management solution. Tenable.sc includes vulnerability scanning and 321 
configuration checking, which displays information through a dashboard graphical user interface. 322 
Tenable.sc’s dashboard includes vulnerability scoring, enabling engineers to prioritize patching and 323 
remediation. This practice guide used Tenable.sc to manage a Nessus scanner, which performed 324 
vulnerability scanning against HDO domain-hosted devices. While the Tenable.sc solution includes 325 
configuration-checking functionality, this practice guide used the solution for vulnerability management. 326 

System Requirements 327 

Central Processing Unit (CPU): 4 328 

Memory: 8 gigabytes (GB) 329 

Storage: 250 GB 330 

Operating System: CentOS 7 331 

Network Adapter: VLAN 1348 332 

Tenable.sc Installation 333 

This section discusses installation of the Tenable.sc vulnerability management solution.  334 

1. Import the Tenable.sc open virtual appliance or appliance (OVA) file to the virtual environment. 335 

2. Assign the virtual machine (VM) to VLAN 1348. 336 
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3. Start the VM and document the associated internet protocol (IP) address. 337 

4. Open a web browser that can talk to virtual local area network (VLAN) 1348 and navigate to the 338 
VM’s IP address. 339 

5. For the first login, use wizard as the Username and admin for the Password. 340 

6. Tenable.sc prompts a popup window for creating a new admin username and password. 341 

7. Repeat step 5 using the new username and password. 342 

a. Username: admin 343 

b. Password: ********** 344 

c. Check the box beside Reuse my password for privileged tasks. 345 

  

8. After logging in, the Tenable Management Console page displays. 346 

9. Click the Tenable.sc menu option on the left side of the screen. 347 

10. To access Tenable.sc, click the IP address next to the uniform resource locator (URL) field. 348 
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11. Log in to Tenable.sc using the credentials created in previous steps, and click Sign In. 349 

a. Username: admin 350 

b. Password: ********** 351 
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12. After signing in, Tenable.sc’s web page displays. 352 

13. Navigate to the System drop-down list in the menu ribbon. 353 

14. Click Configuration. 354 

15. Under Tenable.sc License, click Upload next to License File. 355 

16. Navigate to the storage location of the Tenable.sc license key obtained from a Tenable 356 
representative and select the key file. 357 

17. Click OK. 358 

18. Click Validate. 359 

19. When Tenable.sc accepts the key, a green Valid label will display next to License File. 360 
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20. Under Additional Licenses, input the Nessus license key provided by a Tenable representative 361 
next to Nessus Scanner. 362 

21. Click Register. 363 
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Tenable.sc Configuration 364 

This practice guide leveraged support from Tenable engineers. Collectively, engineers installed 365 
Tenable.sc and validated license keys for Tenable.sc and Nessus. Engineers created Organization, 366 
Repository, User, Scanner, and Scan Zones instances for the HDO lab environment. The configuration 367 
steps are below.  368 

Add an Organization 369 

1. Navigate to Organizations in the menu ribbon. 370 

2. Click +Add in the top right corner of the screen. An Add Organization page will appear. 371 

3. Name the Organization RPM HDO and leave the remaining fields as their default values. 372 

4. Click Submit. 373 



DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 18 

 

Add a Repository 374 

1. Navigate to the Repositories drop-down list in the menu ribbon. 375 

2. Click +Add in the top right corner of the screen. An Add Repository screen displays. 376 

3. Under Local, click IPv4. An Add IPv4 Repository page displays. Provide the following 377 
information: 378 

a. Name: HDO Repository 379 

b. IP Ranges: 0.0.0.0/24 380 

c. Organizations: RPM HDO 381 

4. Click Submit. 382 
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Add a User 383 

1. Navigate to the Users drop-down list in the menu ribbon. 384 

2. Select Users. 385 

3. Click +Add in the top right corner. An Add User page displays. Provide the following information: 386 

a. Role: Security Manager 387 

b. Organization: RPM HDO 388 
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c. First Name: Test 389 

d. Last Name: User 390 

e. Username: TestSecManager 391 

f. Password: ********** 392 

g. Confirm Password: ********** 393 

h. Enable User Must Change Password. 394 

i. Time Zone: America/New York 395 

4. Click Submit. 396 
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For the lab deployment of Tenable.sc, the engineers instantiated one Nessus scanner in the Security 397 
Services subnet that has access to every subnet in the HDO environment. 398 

Add a Scanner 399 

1. Navigate to the Resources drop-down list in the menu ribbon. 400 

2. Select Nessus Scanners. 401 

3. Click +Add in the top right corner. An Add Nessus Scanner page displays. Fill in the following 402 
information: 403 

a. Name: HDO Scanner 404 

b. Description: Scans the Workstation, Enterprise, HIS, Remote, and Database VLANs 405 

c. Host: 192.168.45.100 406 

d. Port: 8834 407 

e. Enabled: on 408 

f. Type: Password 409 

g. Username: TestSecManager 410 

h. Password: ********** 411 

4. Click Submit. 412 
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The engineers created a scan zone for each subnet established on the HDO network. The process to 413 
create a scan zone is the same for each subnet aside from the IP address range.  414 

As an example, the steps for creating the Workstation scan zone are as follows: 415 

Add a Scan Zone 416 

1. Navigate to the Resources drop-down list in the menu ribbon. 417 

2. Select Scan Zones. 418 
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3. Click +Add. An Add Scan Zone page will appear. Provide the following information: 419 

a. Name: Workstations 420 

b. Ranges: 192.168.44.0/24 421 

c. Scanners: HDO Scanner 422 

4. Click Submit. 423 

 

Repeat steps in Add a Scan Zone section for each VLAN. 424 

To fulfil the identified NIST Cybersecurity Framework Subcategory requirements, the engineers utilized 425 
Tenable’s host discovery and vulnerability scanning capabilities. The first goal was to identify the hosts 426 
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on each of the HDO VLANs. Once Tenable identifies the assets, Tenable.sc executes a basic network scan 427 
to identify any vulnerabilities on these assets. 428 

Create Scan Policies 429 

1. Engineers created a Security Manager account in a previous step when adding users. Log in to 430 
Tenable.sc using the Security Manager account.  431 

2. Navigate to the Scans drop-down list in the menu ribbon. 432 

3. Select Policies. 433 

4. Click +Add in the top right corner. 434 

5. Click Host Discovery in the Add Policy page. An Add Policy > Host Discovery page will appear. 435 
Provide the following information: 436 

a. Name: HDO Assets 437 

b. Discovery: Host enumeration 438 

c. Leave the remaining options as their default values. 439 

6. Click Submit. 440 
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7. Click +Add in the top right corner. 441 

8. Click Basic Network Scan in the Add Policy page. An Add Policy > Basic Network Scan page 442 
displays. 443 

9. Name the scan HDO Network Scan and leave the remaining options to their default settings. 444 

10. Click Submit. 445 

 

Create Active Scans 446 

1. Navigate to the Scans drop-down list in the menu ribbon. 447 

2. Select Active Scans. 448 

3. Click +Add in the top right corner. An Add Active Scan page will appear. Provide the following 449 
information for General and Target Type sections. 450 

General 451 

a. Name: Asset Scan 452 

b. Description: Identify hosts on the VLANs 453 

c. Policy: Host Discovery 454 

Targets 455 

a. Target Type: IP/DNS Name 456 
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b. IPs/DNS Names: 192.168.44.0/24, 192.168.40.0/24, 192.168.41.0/24,    457 
      192.168.42.0/24, 192.168.43.0/24 458 

4. Click Submit. 459 
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Repeat steps in Create Active Scans section for the Basic Network Scan policy. Keep the same value as 460 
defined for Active Scan with the exception of the following: 461 

a. Name the scan HDO Network Scan. 462 

b. Set Policy to HDO Network Scan. 463 

After the engineers created and correlated the Policies and Active Scans to each other, they executed 464 
the scans. 465 

Execute Active Scans 466 

1. Navigate to the Scans drop-down list in the menu ribbon. 467 

2. Select Active Scans. 468 

3. Next to HDO Asset Scan click . 469 

4. Navigate to the Scan Results menu option shown at the top of the screen under the menu 470 
ribbon to see the status of the scan. 471 

5. Click HDO Asset Scan to see the scan results. 472 

6. Repeat the above steps for HDO Network Scan. 473 

View Active Scan Results in the Dashboard 474 

1. Navigate to the Dashboard drop-down list in the menu ribbon. 475 

2. Select Dashboard. 476 
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3. In the top right, click Switch Dashboard. 477 

4. Click Vulnerability Overview. A screen will appear that displays a graphical representation of the 478 
vulnerability results gathered during the HDO Host Scan and HDO Network Scan. 479 

2.2.1.2 Nessus 480 

Nessus is a vulnerability scanning engine that evaluates a host’s operating system and configuration to 481 
determine the presence of exploitable vulnerabilities. This project uses one Nessus scanner to scan each 482 
VLAN created in the HDO environment to identify hosts on each VLAN and the vulnerabilities associated 483 
with those hosts. Nessus sends the results back to Tenable.sc, which graphically represents the results in 484 
dashboards. 485 

System Requirements 486 

CPU: 4 487 

Memory: 8 GB 488 

Storage: 82 GB 489 

Operating System: CentOS 7 490 

Network Adapter: VLAN 1348 491 

Nessus Installation 492 

1. Import the OVA file to the virtual lab environment. 493 

2. Assign the VM to VLAN 1348. 494 

3. Start the VM and document the associated IP address. 495 

4. Open a web browser that can talk to VLAN 1348 and navigate to the VM’s IP address. 496 

5. Log in using wizard as the Username and admin for the Password. 497 

6. Create a new admin username and password. 498 

7. Log in using the new username and password. 499 

a. Username: admin 500 

b. Password: ********** 501 

c. Enable Reuse my password for privileged tasks. 502 
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8. Click Tenable.sc on the left side of the screen. 503 

9. To access Tenable.sc, click the IP address next to the URL field. 504 
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Nessus Configuration 505 

The engineers utilized Tenable.sc to manage Nessus. To configure Nessus as managed by Tenable.sc, 506 
follow Tenable’s Managed by Tenable.sc guide [3]. 507 

2.2.2 Identity Management, Authentication, and Access Control 508 

Identity management, authentication, and access control align with the NIST Cybersecurity Framework 509 
PR.AC control. This practice guide implemented capabilities in the HDO to address this control category. 510 
First, the practice guide implemented Microsoft Active Directory (AD), then installed a domain controller 511 
to establish an HDO domain. Next, the practice guide implemented Cisco Firepower as part of its 512 
network core infrastructure. The practice guide used Cisco Firepower to build VLANs that aligned to 513 
network zones. Cisco Firepower also was configured to provide other network services. Details on 514 
installation are included in the following sections. 515 

2.2.2.1 Domain Controller 516 

The engineers installed a Windows Server domain controller within the HDO to manage AD and local 517 
domain name service (DNS) for the enterprise. The following section details how the engineers installed 518 
the services. 519 

Domain Controller Appliance Information 520 
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CPU: 4 521 

Random Access Memory (RAM): 8 GB 522 

Storage: 120 GB (Thin Provision) 523 

Network Adapter 1: VLAN 1327 524 

Operating System: Microsoft Windows Server 2019 Datacenter 525 

Domain Controller Appliance Installation Guide 526 

Install the appliance according to the instructions detailed in Microsoft’s Install Active Directory Domain 527 
Services (Level 100) documentation [4]. 528 

Verify Domain Controller Installation 529 

1. Launch Server Manager. 530 

2. Click Tools > Active Directory Domains and Trusts. 531 

 

3. Right-click hdo.trpm. 532 

4. Click Manage. 533 
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 534 

5. Click hdo.trpm > Domain Controllers. 535 

6. Check that the Domain Controllers directory lists the new domain controller. 536 

 537 

Configure Local DNS 538 

1. Launch Server Manager. 539 

2. Click Tools > DNS. 540 
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3. Click the arrow symbol for DC-HDO. 541 

4. Right-click Reverse Lookup Zones. 542 

5. Click New Zone…. The New Zone Wizard displays. 543 

 

6. Click Next >.  544 
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7. Click Primary zone. 545 

8. Check Store the zone in Active Directory. 546 

9. Click Next >. 547 
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10. Check To all DNS servers running on domain controllers in this forest: hdo.trpm. 548 

11. Click Next >. 549 
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12. Check IPv4 Reverse Lookup Zone. 550 

13. Click Next >. 551 
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14. Check Network ID. 552 

15. Under Network ID, type 192.168. 553 

16. Click Next >. 554 
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17. Check Allow only secure dynamic updates. 555 

18. Click Next >. 556 
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19. Click Finish. 557 
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20. Click the arrow symbol for Reverse Lookup Zones. 558 

21. Right-click 168.192.in-addr.arpa. 559 

22. Click New Pointer (PTR)…. 560 
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23. Under Host name, click Browse…. 561 
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24. Under Look in, select hdo.trpm. 562 

25. Under Records, select dc-hdo. 563 

26. Click OK. 564 
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27. Click OK. 565 
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2.2.2.2 Cisco Firepower 566 

Cisco Firepower consists of two primary components: Cisco Firepower Management Center and Cisco 567 
Firepower Threat Defense (FTD). Cisco Firepower provides firewall, intrusion prevention, and other 568 
networking services. This project used Cisco Firepower to implement VLAN network segmentation, 569 
network traffic filtering, internal and external routing, applying an access control policy, and Dynamic 570 
Host Configuration Protocol (DHCP). Engineers deployed Cisco Firepower as a core component for the 571 
lab’s network infrastructure. 572 

Cisco Firepower Management Center (FMC) Appliance Information 573 

CPU: 4 574 

RAM: 8 GB 575 

Storage: 250 GB (Thick Provision) 576 

Network Adapter 1: VLAN 1327 577 

Operating System: Cisco Fire Linux 6.4.0 578 

Cisco Firepower Management Center Installation Guide 579 

Install the appliance according to the instructions detailed in the Cisco Firepower Management Center 580 
Virtual Getting Started Guide [5]. 581 

Cisco FTD Appliance Information 582 

CPU: 8 583 
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RAM: 16 GB 584 

Storage: 48.5 GB (Thick Provision) 585 

Network Adapter 1: VLAN 1327 586 

Network Adapter 2: VLAN 1327 587 

Network Adapter 3: VLAN 1316 588 

Network Adapter 4: VLAN 1327 589 

Network Adapter 5: VLAN 1328 590 

Network Adapter 6: VLAN 1329 591 

Network Adapter 7: VLAN 1330 592 

Network Adapter 8: VLAN 1347 593 

Network Adapter 9: VLAN 1348 594 

Operating System: Cisco Fire Linux 6.4.0 595 

Cisco FTD Installation Guide 596 

Install the appliance according to the instructions detailed in the Cisco Firepower Threat Defense Virtual 597 
for VMware Getting Started Guide in the “Deploy the Firepower Threat Defense Virtual” chapter [6]. 598 

Configure FMC Management of FTD 599 

The Cisco Firepower Threat Defense Virtual for VMware Getting Started Guide’s “Managing the 600 
Firepower Threat Defense Virtual with the Firepower Management Center” (FMC) chapter covers how 601 
we registered the FTD appliance with the FMC [7]. 602 

Once the FTD successfully registers with the FMC, it will appear under Devices > Device Management in 603 
the FMC interface. 604 
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From the Device Management section, the default routes, interfaces, and DHCP settings can be 605 
configured. To view general information for the FTD appliance, navigate to Devices > Device 606 
Management > FTD-TRPM > Device. 607 
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Configure Cisco FTD Interfaces for the RPM Architecture 608 

By default, each of the Interfaces are defined as GigabitEthernet, and are denoted as 0 through 6.  609 
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1. From Devices > Device Management > FTD-TRPM > Device, click Interfaces.  610 

2. On the Cisco FTD Interfaces window, an Edit icon appears on the far right. The first 611 
GigabitEthernet interface configured is GigabitEthernet0/0. Click on the Edit icon to configure 612 
the GigabitEthernet interface.  613 

 

3. The Edit Physical Interface group box displays. Under the General tab, enter WAN in the Name 614 
field. 615 
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4. Under Security Zone, click the drop-down arrow and select New…. 616 
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5. The New Security Zone pop-up box appears. Enter WAN in the Enter a name… field.  617 

6. Click OK. 618 
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7. On the Edit Physical Interface page group box, click the IPv4 tab. 619 
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8. Fill out the following information: 620 

a. IP Type: Use Static IP 621 

b. IP Address: 192.168.4.50/24 622 

c. Click OK. 623 
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9. Configure each of the other GigabitEthernet interfaces following the same pattern described 624 
above, populating the respective IP addresses that correspond to the appropriate VLAN. Values 625 
for each VLAN are described below: 626 

a. GigabitEthernet0/0 (VLAN 1316) 627 

i. Name: WAN 628 

ii. Security Zone: WAN 629 

iii. IP Address: 192.168.4.50/24 630 

b. GigabitEthernet0/1 (VLAN 1327) 631 

i. Name: Enterprise-Services 632 

ii. Security Zone: Enterprise-Services 633 

iii. IP Address: 192.168.40.1/24 634 

c. GigabitEthernet0/2 (VLAN 1328) 635 

i. Name: HIS-Services 636 
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ii. Security Zone: HIS-Services 637 

iii. IP Address: 192.168.41.1/24 638 

d. GigabitEthernet0/3 (VLAN 1329) 639 

i. Name: Remote-Services 640 

ii. Security Zone: Remote-Services 641 

iii. IP Address: 192.168.42.1/24 642 

e. GigabitEthernet0/4 (VLAN 1330) 643 

i. Name: Databases 644 

ii. Security Zone: Databases 645 

iii. IP Address: 192.168.43.1/24 646 

f. GigabitEthernet0/5 (VLAN 1347) 647 

i. Name: Clinical-Workstations 648 

ii. Security Zone: Clinical-Workstations 649 

iii. IP Address: 192.168.44.1/24 650 

g. GigabitEthernet0/6 (VLAN 1348) 651 

i. Name: Security-Services 652 

ii. Security Zone: Security-Services 653 

iii. IP Address: 192.168.45.1/24 654 

10. Click Save. 655 

11. Click Deploy. Verify that the Interfaces have been configured properly. Selecting the Devices 656 
tab, the Device Management screen displays the individual interfaces, the assigned logical 657 
names, type of interface, security zone labelling, and the assigned IP address network that 658 
corresponds to the VLANs that are assigned per security zone. 659 
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Configure Cisco FTD DHCP 660 

1. From Devices > Device Management > FTD-TRPM > Interfaces, click DHCP. 661 

2. Click the plus symbol next to Primary DNS Server. 662 

 

3. The New Network Object popup window appears. Fill out the following information: 663 

a. Name: Umbrella-DNS-1 664 

b. Network (Host): 192.168.40.30 665 
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4. Click Save. 666 

 

5. Click the plus symbol next to Secondary DNS Server. 667 

6. The New Network Object popup window appears. Fill out the following information: 668 

a. Name: Umbrella-DNS-2 669 

b. Network (Host): 192.168.40.31 670 

7. Under Domain Name, add hdo.trpm. 671 

8. Click Add Server. 672 

 

9. The Add Server popup window appears. Fill out the following information: 673 

a. Interface: Enterprise-Services 674 
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b. Address Pool: 192.168.40.100-192.168.40.254 675 

c. Enable DHCP Server: Checked 676 

10. Click OK. 677 

 

11. Add additional servers following the same pattern described above, populating the respective 678 
Interface, Address Pool and check the Enable DHCP Server that correspond to the appropriate 679 
server. Values for each server are described below: 680 

a. Interface: Enterprise-Services 681 

i. Address Pool: 192.168.40.100-192.168.40.254 682 

ii. Enable DHCP Server: Checked 683 

b. Interface: HIS-Services 684 

i. Address Pool: 192.168.41.100-192.168.41.254 685 

ii. Enable DHCP Server: Checked 686 

c. Interface: Remote-Services 687 

i. Address Pool: 192.168.42.100-192.168.42.254 688 

ii. Enable DHCP Server: Checked 689 

d. Interface: Databases 690 

i. Address Pool: 192.168.43.100-192.168.43.254 691 

ii. Enable DHCP Server: Checked 692 

e. Interface: Clinical-Workstations 693 
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i. Address Pool: 192.168.44.100-192.168.44.254 694 

ii. Enable DHCP Server: Checked 695 

f. Interface: Security-Services 696 

i. Address Pool: 192.168.45.100-192.168.45.254 697 

ii. Enable DHCP Server: Checked 698 

12. Click Save. 699 

13. Click Deploy. Verify that the DHCP servers have been configured properly. Select the Devices tab 700 
and review the DHCP server configuration settings. Values for Ping Timeout and Lease Length 701 
correspond to default values which were not altered. The Domain Name is set to hdo.trpm, 702 
with values that were set for the primary and secondary DNS servers. Below the DNS server 703 
settings, a Server tab displays the DHCP address pool that corresponds to each security zone. 704 
Under the Interface heading, one should view each security zone label that aligns to the 705 
assigned Address Pool and review that the Enable DHCP Server setting appears as a green check 706 
mark. 707 
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Configure Cisco FTD Static Route 708 

1. From Devices > Device Management > FTD-TRPM > DHCP, click Routing. 709 

2. Click Static Route. 710 
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3. Click Add Route. 711 

 

4. The Add Static Route Configuration popup window appears. Fill out the following information: 712 

a. Interface: WAN 713 

b. Selected Network: any-ipv4 714 
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5. Click the plus symbol next to Gateway. 715 

 

6. The New Network Object popup window appears. Fill out the following information: 716 

a. Name: HDO-Upstream-Gateway 717 

b. Network (Host): 192.168.4.1 718 

7. Click Save. 719 
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8. Click OK. 720 
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9. Click Save. 721 

10. Click Deploy. Verify that the static route has been set correctly. From Devices, selecting the 722 
Routing tab, the Static Route will indicate the network routing settings. The screen displays the 723 
static route settings in a table format that includes values for Network, Interface, Gateway, 724 
Tunneled and Metric. The static route applies to the IP addressing that has been specified, 725 
where network traffic traverses the interface. Note the Gateway value. The Tunneled and 726 
Metric values display the default value. 727 
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Configure Cisco FTD Network Address Translation (NAT) 728 

1. Click Devices > NAT. 729 

2. Click New Policy > Threat Defense NAT. 730 

 

3. The New Policy popup window appears. Fill out the following information: 731 

a. Name: TRPM NAT 732 

b. Selected Devices: FTD-TRPM 733 

4. Click Save. 734 



DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 66 

 

5. Click the edit symbol for TRPM NAT. 735 

 

6. Click Add Rule. 736 
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7. The Edit NAT Rule popup window appears. Under Interface Objects, fill out the following 737 
information: 738 

a. NAT Rule: Auto NAT Rule 739 

b. Type: Dynamic 740 

c. Source Interface Objects: Enterprise-Services 741 

d. Destination Interface Objects: WAN 742 

8. Click Translation. 743 

 

9. Under Translation, fill out the following information: 744 

a. Original Source: Enterprise-Services 745 

b. Translated Source: Destination Interface IP 746 

10. Click OK. 747 
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11. Create addition rules following the same pattern described above, populating the respective 748 
information for each rule. Values for each rule are described below: 749 

a. HIS-Services 750 

i. NAT Rule: Auto NAT Rule 751 

ii. Type: Dynamic 752 

iii. Source Interface Objects: HIS-Services 753 

iv. Destination Interface Objects: WAN 754 

v. Original Source: HIS-Services 755 

vi. Translated Source: Destination Interface IP 756 

b. Remote-Services 757 

i. NAT Rule: Auto NAT Rule 758 

ii. Type: Dynamic 759 

iii. Source Interface Objects: Remote-Services 760 

iv. Destination Interface Objects: WAN 761 

v. Original Source: Remote-Services 762 

vi. Translated Source: Destination Interface IP 763 
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c. Databases 764 

i. NAT Rule: Auto NAT Rule 765 

ii. Type: Dynamic 766 

iii. Source Interface Objects: Databases 767 

iv. Destination Interface Objects: WAN 768 

v. Original Source: Databases 769 

vi. Translated Source: Destination Interface IP 770 

d. Clinical-Workstations 771 

i. NAT Rule: Auto NAT Rule 772 

ii. Type: Dynamic 773 

iii. Source Interface Objects: Clinical-Workstations 774 

iv. Destination Interface Objects: WAN 775 

v. Original Source: Clinical-Workstations 776 

vi. Translated Source: Destination Interface IP 777 

e. Security-Services 778 

i. NAT Rule: Auto NAT Rule 779 

ii. Type: Dynamic 780 

iii. Source Interface Objects: Security-Services 781 

iv. Destination Interface Objects: WAN 782 

v. Original Source: Security-Services 783 

vi. Translated Source: Destination Interface IP 784 

12. Click Save. 785 

13. Click Deploy. Verify the NAT settings through the Devices screen. The NAT rules are displayed in 786 
a table format. The table includes values for Direction of the NAT displayed as a directional 787 
arrow, the NAT Type, the Source Interface Objects (i.e. the security zone IP networks), the 788 
Destination Interface Objects, the Original Sources (i.e. these addresses correspond to the IP 789 
network from where the network traffic originates), the Translated Sources, and Options. The 790 
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settings indicate that IP addresses from the configured security zones are translated behind the 791 
Interface IP address. 792 

 

Configure Cisco FTD Access Control Policy 793 

1. Click Polices > Access Control > Access Control. 794 

2. Click the edit symbol for Default-TRPM. 795 

 

3. Click Add Category. 796 
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4. Fill out the following information: 797 

a. Name: Security Services 798 

b. Insert: into Mandatory 799 

5. Click OK. 800 

 

6. Repeat the previous steps of Add Category section for each network segment in the 801 
architecture. 802 

7. Click Add Rule. 803 

 

8. The Add Rule screen appears, fill out the following information: 804 

a. Name: Nessus-Tenable 805 

b. Action: Allow 806 

c. Insert: into Category, Security Services 807 

d. Under Networks, click the plus symbol next to Available Networks, and select Add 808 
Object. 809 
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9. The New Network Object pop-up window appears, fill out the following information: 810 

a. Name: Tenable.sc 811 

b. Network (Host): 192.168.45.101 812 

10. Click Save. 813 

 

11. In the Add Rule screen, under the Networks tab, set Destination Networks to Tenable.sc. 814 

12. Click Ports. 815 
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13. In the Add Rule screen, under the Ports tab, set Selected Destination Ports to 8834. 816 

14. Click Add. 817 

 

15. Repeat the previous steps for any network requirement rules if necessary. 818 

16. Click Save. 819 

17. Click Deploy. 820 

2.2.3 Security Continuous Monitoring 821 

This practice guide implemented a set of tools that include Cisco Stealthwatch, Cisco Umbrella, and 822 
LogRhythm to address security continuous monitoring. This practice guide uses Cisco Stealthwatch for 823 
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NetFlow analysis. Cisco Umbrella is a service used for DNS-layer monitoring. The LogRhythm tools 824 
aggregate log file information from across the HDO infrastructure and allow behavioral analytics.  825 

2.2.3.1 Cisco Stealthwatch 826 

Cisco Stealthwatch provides network visibility and analysis through network telemetry. This project 827 
integrates Cisco Stealthwatch with Cisco Firepower, sending NetFlow directly from the Cisco FTD 828 
appliance to a Stealthwatch Flow Collector (SFC) for analysis. 829 

Cisco Stealthwatch Management Center (SMC) Appliance Information 830 

CPU: 4 831 

RAM: 16 GB 832 

Storage: 200 GB (Thick Provision) 833 

Network Adapter 1: VLAN 1348 834 

Operating System: Linux 835 

Cisco SMC Appliance Installation Guide 836 

Install the appliance according to the instructions detailed in the Cisco Stealthwatch Installation and 837 
Configuration Guide 7.1 [8]. 838 

Cisco SFC Appliance Information 839 

CPU: 4 840 

RAM: 16 GB 841 

Storage: 300 GB (Thick Provision) 842 

Network Adapter 1: VLAN 1348 843 

Operating System: Linux 844 

Cisco SFC Appliance Installation Guide 845 

Install the appliance according to the instructions detailed in the Cisco Stealthwatch Installation and 846 
Configuration Guide 7.1 [8]. 847 

Accept the default port value 2055 for NetFlow.  848 

Configure Cisco FTD NetFlow for Cisco SFC 849 

1. Click Objects > Object Management > FlexConfig > Text Object. 850 
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2. In the search box, type netflow. 851 

3. Click the edit symbol for netflow_Destination. 852 

 

4. The Edit Text Object popup window appears, fill out the following information: 853 

a. Count: 3 854 

b. 1: Security Services 855 

c. 2: 192.168.45.31 856 

d. 3: 2055 857 

e. Allow Overrides: Checked 858 

5. Click Save. 859 
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6. Click the edit symbol for netflow_Event_Types. 860 
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7. The Edit Text Object popup window appears, fill out the following information: 861 

a. Count: 1 862 

b. 1: All 863 

c. Allow Overrides: Checked 864 

8. Click Save. 865 
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9. Click Devices > FlexConfig. 866 

10. Click New Policy. 867 

 

11. The New Policy screen appears, fill out the following information: 868 

a. Name: FTD-FlexConfig 869 

b. Selected Devices: FTD-TRPM 870 

12. Click Save. 871 
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13. Click the edit symbol for FTD-FlexConfig. 872 

 

14. Under the Devices tab, select Netflow_Add_Destination and Netflow_Set_Parameters. 873 

15. Click the right-arrow symbol to move the selections to the Selected Append FlexConfigs 874 
section. 875 
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16. Click Save. 876 

17. Click Deploy. From the Devices screen, verify the FlexConfig settings. Select the FlexConfig tab. 877 
The NetFlow configurations appear in the lower right of the screen as a table. Under Selected 878 
Append FlexConfigs, the table includes columns labelled # which corresponds to the number of 879 
configurations that have been made, Name and Description. 880 
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Creating a Custom Policy Management Rule 881 

1. Click Configure > Policy Management. 882 

 

2. Click Create New Policy > Role Policy. 883 
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3. Give the policy a name and description. 884 
4. Under Host Groups, click the plus symbol. 885 

 

5. Under Outside Hosts, select Eastern Asia and Eastern Europe. 886 
6. Click Apply. 887 
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7. Under Core Events, click Select Events. 888 
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8. Select Recon. 889 
9. Click Apply. 890 
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10. Under Core Events > Recon > When Host is Source, select On + Alarm. 891 
11. Click the expand arrow next to Recon. 892 

 

12. Select Behavioral and Threshold. 893 
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13. Click Save. 894 
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2.2.3.2 Cisco Umbrella 895 

Cisco Umbrella is a cloud service that provides protection through DNS-layer security. Engineers 896 
deployed two Umbrella virtual appliances in the HDO to provide DNS routing and protection from 897 
malicious web services. 898 

Cisco Umbrella Forwarder Appliance Information 899 

CPU: 1 900 

RAM: 0.5 GB 901 

Storage: 6.5 GB (Thick Provision) 902 

Network Adapter 1: VLAN 1327 903 

Operating System: Linux 904 

Cisco Umbrella Forwarder Appliance Installation Guide 905 

Install the appliance according to the instructions detailed in Cisco’s Deploy VAs in VMware guidance [9]. 906 

Create an Umbrella Site 907 

1. Click Deployments > Configuration > Sites and Active Directory. 908 

2. Click Settings. 909 

 

3. Click Add New Site. 910 
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4. In the Add New Site popup window, set Name to HDO. 911 

5. Click Save. 912 

 

6. Click Deployments > Configuration > Sites and Active Directory. 913 

7. Click the edit symbol for the Site of forwarder-1. 914 

8. Under Site, select HDO. 915 

9. Click Save. 916 
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10. Repeat the previous steps for forwarder-2. 917 

 

Configure an Umbrella Policy 918 

1. Click Policies > Management > All Policies. 919 

2. Click Add. 920 

 

3. Expand the Sites identity. 921 
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4. Select HDO. 922 

5. Click Next. 923 
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6. Click Next. 924 
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7. Click Next. 925 

 

8. Select Moderate. 926 

9. Click Next. 927 
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10. Under Application Settings, use the drop-down menu to select Create New Setting. 928 

 

11. Under the Control Applications screen, fill out the following information: 929 
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a. Name: HDO Application Control 930 

b. Applications to Control: Cloud Storage 931 

12. Click Save. 932 

 

13. Click Next. 933 
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14. Click Next. 934 
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15. Click Next. 935 

 

16. Click Next. 936 
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17. In the Policy Summary screen, set the Name to HDO Site Policy.  937 

18. Click Save. 938 
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Configure Windows Domain Controller as the Local DNS Provider 939 

1. Click Deployments > Configuration > Domain Management. 940 

2. Click Add. 941 
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3. Add New Bypass Domain or Server popup window appears, fill out the following information: 942 

a. Domain: hdo.trpm 943 

b. Applies To: All Sites, All Devices 944 

4. Click Save. Verify the rule for the hdo.trpm has been added. 945 
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2.2.3.3 LogRhythm XDR (Extended Detection and Response) 946 

LogRhythm XDR is a SIEM system that receives log and machine data from multiple end points and 947 
evaluates the data to determine when cybersecurity events occur. The project utilizes LogRhythm XDR in 948 
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the HDO environment to enable a continuous view of business operations and detect cyber threats on 949 
assets. 950 

System Requirements 951 

CPU: 20 virtual central processing unit (vCPU) 952 

Memory: 96 GB RAM 953 

Storage: 954 

 hard drive C: 220 GB 955 
 hard drive D: 1 terabyte (TB) 956 
 hard drive L: 150 GB 957 

Operating System: Microsoft Windows Server 2016 X64 Standard Edition 958 

Network Adapter: VLAN 1348 959 

LogRhythm XDR Installation 960 

This section describes LogRhythm installation processes.  961 

Download Installation Packages 962 

1. Acquire the installation packages from LogRhythm, Inc.  963 

2. Prepare a virtual Windows Server per the system requirements.  964 

3. Create three new drives.  965 

4. Create a new folder from C:\ on the Platform Manager server and name the folder LogRhythm.  966 

5. Extract the provided Database Installer tool and LogRhythm XDR Wizard from the installation 967 
package in C:\LogRhythm. 968 

Install Database 969 

1. Open LogRhythmDatabaseInstallTool folder. 970 

2. Double-click LogRhythmDatabaseInstallTool application file. 971 

3. Click Run. 972 

4. A LogRhythm Database Setup window will appear. Provide the following information: 973 

a. Which setup is this for?: PM 974 

b. Disk Usage: 975 
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             Data: E:\ 976 
             Logs: L:\ 977 
             Temp: T:\ 978 

 

5. The remaining fields will automatically populate with the appropriate values. Click Install. 979 

6. Click Done to close the LogRhythm Database Setup window. 980 

Install LogRhythm XDR 981 

1. Navigate to C:\ and open LogRhythm XDR Wizard folder. 982 

2. Double-click the LogRhythmInstallerWizard application file. 983 

3. The LogRhythm Install Wizard 7.4.8 window will appear. 984 

4. Click Next. 985 

5. A LogRhythm Install Wizard Confirmation window will appear. 986 

6. Click Yes to continue. 987 

7. Check the box beside I accept the terms in the license agreement to accept the License 988 
Agreement. 989 

8. Click Next. 990 
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9. In the Selected Applications window, select the following attributes: 991 

a. Configuration: Select the XM radio button. 992 

b. Optional Applications: Check both AI Engine and Web Console boxes. 993 

10. Click Install. 994 

 

11. A LogRhythm Deployment Tool window displays. 995 

12. Click Configure New Deployment. 996 
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13. In the Deployment Properties window, keep the default configurations and click Ok. 997 
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14. Click +Add Host IP in the bottom right corner of the screen, and provide the following 998 
information:  999 

a. IP Address: 192.168.45.20 1000 

b. Nickname: XM 1001 

15. Click Save. 1002 
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16. Click Create Deployment Package in the bottom right corner of the screen. 1003 

17. A Create Deployment Package window displays.  1004 

18. Click Create Deployment Package. 1005 

 

19. A Select Folder window appears. 1006 

20. Navigate to C:\LogRhythm. 1007 

21. Click Select Folder. 1008 
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22. Click Next Step. 1009 

 

23. Click Run Host Installer on this Host. 1010 
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24. After the Host Installer has finished, click Verify Status. 1011 

 

25. Click Exit to Install Wizard. 1012 
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26. A notification window displays stating the installation could take up to 30 minutes. Click OK.  1013 
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27. After the Install Wizard has successfully installed the services, click Exit. 1014 
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LogRhythm XDR Configuration 1015 

The LogRhythm XDR configuration includes multiple related components: 1016 

 System Monitor 1017 

 LogRhythm Artificial Intelligence (AI) Engine 1018 

 Mediator Server 1019 

 Job Manager 1020 

 LogRhythm Console 1021 

Configure System Monitor 1022 

1. Open File Explorer and navigate to C:\Program Files\LogRhythm. 1023 

2. Navigate to LogRhythm System Monitor. 1024 

3. Double-click the lrconfig application file. 1025 

4. In the LogRhythm System Monitor Local Configuration Manager window, provide the following 1026 
information and leave the remaining fields as their default values: 1027 

a. Data Processor Address: 192.168.45.20 1028 

b. System Monitor IP Address/Index: 192.168.45.20  1029 

5. Click Apply, and then click OK. 1030 
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Configure LogRhythm AI Engine 1031 

1. Open File Explorer and navigate to C:\Program Files\LogRhythm. 1032 

2. Navigate to LogRhythm AI Engine. 1033 

3. Double-click the lrconfig application file. 1034 

4. In the LogRhythm AI Engine Local Configuration Manager window, provide the following 1035 
information, and leave the remaining fields as their default values: 1036 

a. Server: 192.168.45.20 1037 

b. Password: ********** 1038 

5. Click Test Connection, then follow the instruction of the alert window to complete the test 1039 
connection. 1040 

6. Click Apply, and then click OK. 1041 
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Configure Mediator Server 1042 

1. Open File Explorer and navigate to C:\Program Files\LogRhythm. 1043 

2. Navigate to Mediator Server. 1044 

3. Double-click lrconfig application file. 1045 

4. In the LogRhythm Data Processor Local Configuration Manager window, provide the following 1046 
information, and leave the remaining fields as their default values: 1047 

a. Server: 192.168.45.20 1048 

b. Password: ********** 1049 

 1050 
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5. Click Test Connection, then follow the instruction of the alert window to complete the test 1051 
connection. 1052 

6. Click Apply, and then click OK. 1053 

 

Configure Job Manager 1054 
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1. Open File Explorer and navigate to C:\Program Files\LogRhythm. 1055 

2. Navigate to Job Manager. 1056 

3. Double-click the lrconfig application file. 1057 

4. In the LogRhythm Platform Manager Local Configuration Manager window, provide the 1058 
following information, and leave the remaining fields as their default values: 1059 

a. Server: 192.168.45.20 1060 

b. Password: ********** 1061 

5. Click Test Connection, then follow the instruction of the alert window to complete the test 1062 
connection. 1063 

6. Click Apply, and then click OK. 1064 



DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 116 

 

7. Navigate to the Alarming and Response Manager tab in the bottom menu ribbon. 1065 

8. In the Alarming and Response Manager window, provide the following information, and leave 1066 
the remaining fields as their default values: 1067 

a. Server: 192.168.45.20 1068 
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b. Password: ********** 1069 

9. Click Test Connection, then follow the instruction of the alert window to complete the test 1070 
connection. 1071 

10. Click Apply, and then click OK. 1072 
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Configure LogRhythm Console 1073 

1. Open File Explorer and navigate to C:\Program Files\LogRhythm. 1074 

2. Navigate to LogRhythm Console. 1075 
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3. Double-click lrconfig application file. 1076 

4. In the LogRhythm Login window, provide the following information: 1077 

a. EMDB Server: 192.168.45.20 1078 

b. UserID: LogRhythmAdmin 1079 

c. Password: ******** 1080 

5. Click OK. 1081 

 

6. A New Platform Manager Deployment Wizard window displays. Provide the following 1082 
information: 1083 

a. Windows host name for Platform Manager: LogRhythm-XDR 1084 

b. IP Address for Platform Manager: 192.168.45.20 1085 

c. Check the box next to The Platform Manager is also a Data Processor (e.g., an XM 1086 
appliance). 1087 



DRAFT 

NIST SP 1800-30C: Securing Telehealth Remote Patient Monitoring Ecosystem 120 

d. Check the box next to The Platform Manager is also an AI Engine Server. 1088 

7. Click the ellipsis button next to <Path to LogRhythm License File> and navigate to the location 1089 
of the LogRhythm License File. 1090 

 

8. The New Knowledge Base Deployment Wizard window displays and shows the import progress 1091 
status. Once LogRhythm has successfully imported the file, a message window will appear 1092 
stating more configurations need to be made for optimum performance. Click OK to open the 1093 
Platform Manager Properties window. 1094 

9. In the Platform Manager Properties window, provide the following information: 1095 

a. Email address: no_reply@logrhythm.com 1096 

b. Address: 192.168.45.20 1097 

10. Click the button next to Platform, enable the Custom Platform radio button, and complete the 1098 
process by clicking Apply, followed by clicking OK. 1099 

mailto:no_reply@logrhythm.com
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11. After the Platform Manager Properties window closes, a message window displays for 1100 
configuring the Data Processor. Click OK to open the Data Processor Properties window. 1101 

12. Click the button next to Platform and enable the Custom Platform radio button. 1102 

13. Click OK.  1103 

14. Leave the remaining fields in the Data Processor Properties window as their default values and 1104 
click Apply.  1105 

15. Click OK to close the window. 1106 
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Set LogRhythm-XDR for System Monitor 1107 

1. Back in the LogRhythm console, navigate to the Deployment Manager tab in the menu ribbon. 1108 

2. Navigate to System Monitors on the Deployment Manager menu ribbon. 1109 

3. Double-click LogRhythm-XDR. 1110 
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4. In the System Monitor Agent Properties window, navigate to Syslog and Flow Settings. 1111 

5. Click the checkbox beside Enable Syslog Server. 1112 

6. Click OK to close the System Monitor Agent Properties window. 1113 

 

Use the LogRhythm Web Console 1114 

1. Open a web browser and navigate to https://localhost:8443. 1115 
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2. Enter the Username: logrhythmadmin 1116 

3. Enter the Password: ********** 1117 

 

2.2.3.4 LogRhythm NetworkXDR 1118 

LogRhythm NetworkXDR paired with LogRhythm XDR enables an environment to monitor network 1119 
traffic between end points and helps suggest remediation techniques for identified concerns. This 1120 
project utilizes NetworkXDR for continuous visibility on network traffic between HDO VLANs and 1121 
incoming traffic from the telehealth platform provider. 1122 

System Requirements 1123 

CPU: 24 vCPU 1124 

Memory: 64 GB RAM 1125 

Storage: 1126 
 Operating System Hard Drive: 220 GB 1127 
 Data Hard Drive: 3 TB 1128 
 Operating System: CentOS 7 1129 

 1130 

Network Adapter: VLAN 1348 1131 

LogRhythm NetworkXDR Installation 1132 

LogRhythm provides an International Organization for Standardization (.iso) disk image to simplify 1133 
installation of NetMon. The .iso is a bootable image that installs CentOS 7.7 Minimal and NetMon. Note: 1134 
Because this is an installation on a Linux box, there is no need to capture the screenshots. 1135 
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Download the Installation Software 1136 

1. Open a new tab in the web browser and navigate to https://community.logrhythm.com. 1137 

2. Log in using the appropriate credentials. 1138 

3. Click LogRhythm Community. 1139 

4. Navigate to Documentation & Downloads. 1140 

5. Register a Username. 1141 

6. Click Accept. 1142 

7. Click Submit. 1143 

8. Navigate to NetMon. 1144 

9. Click downloads: netmon4.0.2. 1145 

10. Select NetMon ISO under Installation Files. 1146 

Create a New Firewall Rule 1147 

NetMon communicates over TCP 443. The lab environment was configured to allow network sessions 1148 
connecting to the LogRhythm agent.  1149 

Install LogRhythm NetworkXDR 1150 

1. In the host server, mount the .iso for the installation. 1151 

2. Start the VM with the mounted .iso. 1152 

3. When the welcome screen loads, select Install LogRhythm Network Monitor. 1153 

4. The installer completes the installation, and the system reboots. 1154 

5. When the system reboots, log in to the console by using logrhythm as the login and ****** as 1155 
the password. 1156 

6. Then change the password by typing the command passwd, type the default password, and then 1157 
type and verify the new password. 1158 

LogRhythm NetworkXDR Configuration 1159 
 1160 

1. Data Process Address: 192.168.45.20 1161 

2. Click Apply. 1162 

https://community.logrhythm.com/
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3. Click the Windows Service tab. 1163 

4. Change the Service Type to Automatic. 1164 

5. Click Apply. 1165 
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6. Click the Log File tab. 1166 

7. Click Refresh to ensure NetworkXDR log collection.  1167 

8. Click OK to exit the Local Configuration Manager. 1168 
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2.2.3.5 LogRhythm System Monitor Agent 1169 

LogRhythm System Monitor Agent is a component of LogRhythm XDR that receives end-point log files 1170 
and machine data in an IT infrastructure. The system monitor transmits ingested data to LogRhythm XDR 1171 
where a web-based dashboard displays any identified cyber threats. This project deploys LogRhythm’s 1172 
System Monitor Agents on end points in each identified VLAN. 1173 

Install the LogRhythm System Monitor Agent on one of the end points (e.g., Clinical Workstation) in the 1174 
HDO environment so that the LogRhythm XDR can monitor the logs, such as syslog and eventlog, of this 1175 
workstation. 1176 

System Monitor Agent Installation 1177 
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This section describes installation of the system monitor agent.  1178 

Download Installation Packages 1179 

1. Using a Clinical Workstation, open a web browser. 1180 

2. Navigate to https://community.logrhythm.com. 1181 

3. Log in using the credentials made when installing and configuring LogRhythm XDR. 1182 

4. Navigate to LogRhythm Community. 1183 

5. Click Documents & Downloads. 1184 

6. Click SysMon. 1185 

7. Click SysMon – 7.4.10. 1186 

8. Click Windows System Monitor Agents and save to the Downloads folder on the Workstation. 1187 

Install System Monitor Agent 1188 

1. On the Workstation, navigate to Downloads folder. 1189 

2. Click LRWindowsSystemMonitorAgents. 1190 

3. Click LRSystemMonitor_64_7. 1191 

4. On the Welcome page, follow the Wizard, and click Next… 1192 

 
 

https://community.logrhythm.com/
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5. On the ready to begin installation page, click Install. 1193 

 

6. Click Finish. 1194 

 

System Monitor Agent Configuration 1195 

1. After exiting the LogRhythm System Monitor Service Install Wizard, a LogRhythm System 1196 
Monitor Local Configuration window displays. Under the General tab, provide the following 1197 
information: 1198 
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a. Data Process Address: 192.168.45.20 1199 

b. System Monitor IP Address/Index: 192.168.45.20 1200 

2. Click Apply. 1201 

 

3. Click the Windows Service tab. 1202 

4. Change the Service Type to Automatic. 1203 

5. Click Apply. 1204 
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6. Click the Log File tab. 1205 

7. Click Refresh to ensure NetworkXDR log collection. 1206 

8. Click OK to exit the Local Configuration Manager. 1207 
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Add Workstation for System Monitor 1208 

Engineers added Clinical Workstation for System Monitor and Set Its Message Source Types in the 1209 
LogRhythm Deployment Manager. 1210 

1. Log in to the LogRhythm Console.  1211 

a. User ID: LogRhythmAdmin 1212 

b. Password: ********** 1213 
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2. Navigate to the Deployment Manager in the menu ribbon. 1214 

3. Under the Entity tab on the Deployment Manager menu ribbon. 1215 

4. Click New to open the Host pop-up window, and enter the following under the Basic 1216 
Information tab: 1217 

a. Name: ClinicalWS 1218 

b. Host Zone: Internal 1219 
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5. Navigate to the Identifiers tab, provide the following information in the appropriate fields, and 1220 
click Add. 1221 

a. IP Address: 192.168.44.251 1222 

b. Windows Name: clinicalws (Windows Name) 1223 
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6. Add the ClinicalWS as a new system monitor agent by navigating to the System Monitors tab, 1224 
right-clicking in the empty space, and selecting New. 1225 

7. In the System Monitor Agent Properties window, click the button next to Host Agent is Installed 1226 
on, and select Primary Site: ClinicalWS. 1227 
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8. Go to System Monitors. 1228 

9. Double-click ClinicalWS. 1229 

10. Under LogSource of the System Monitor Agent Property window, right-click in the empty space, 1230 
and select New. The Log Message Source Property window will open. 1231 

11. Under the Log Message Source Property window, click the button associated with Log Message 1232 
Source Type. It will open the Log Source Selector window. 1233 

12. In the text box to the right of the Log Source Selector window, type XML, and click Apply. 1234 

13. Select the Log Source Type and click OK. 1235 
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Appendix A List of Acronyms 1236 

AD Active Directory 

CPU Central Processing Unit  

DHCP Dynamic Host Configuration Protocol 

DNS Domain Name Service 

FMC Firepower Management Center 
FTD Firepower Threat Defense 

GB Gigabyte 

HDO Healthcare Delivery Organization 

IP Internet Protocol 

ISO International Organization for Standardization 

IT Information Technology 
NAT Network Address Translation 

NCCoE National Cybersecurity Center of Excellence 

NIST National Institute of Standards and Technology 

OVA Open Virtual Appliance or Application 

PACS Picture Archiving and Communication System 

RAM Random Access Memory 
RPM Remote Patient Monitoring 

SFC Stealthwatch Flow Collector 

SIEM Security Incident Event Management 

SMC Stealthwatch Management Center 

SP Special Publication 

TB Terabyte 
URL Uniform Resource Locator 

vCPU Virtual Central Processing Unit 

VLAN Virtual Local Area Network 

VM Virtual Machine 

XDR Extended Detection and Response 
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